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前言 

  在进行以下操作之前，请先安装 CCS，推荐使用我司验证过的 CCS5.5.0 版本。

安装包 CCS5.5.0.00077_win32.zip 可以在 TMS320C6748 产品资料光盘的 tools 目录

下找到，也可以在 TI 官网下载，可以下载各种版本的 CCS。下载前需要注册一个

TI账号，注册后才能用账号去下载CCS和其他文件，然后再去网上找一个破解文件，

安装后按照破解文件指定步骤操作即可正常使用 CCS5 了。 

  TI 官网下载链接：  

http://processors.wiki.ti.com/index.php/Download_CCS#Code_Composer_Studio_Versio

n_5_Downloads 

  

http://processors.wiki.ti.com/index.php/Download_CCS#Code_Composer_Studio_Version_5_Downloads
http://processors.wiki.ti.com/index.php/Download_CCS#Code_Composer_Studio_Version_5_Downloads
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1  开发板准备 

1.1 测试开发板硬件 

 将开发板的拨码开关 1~5 号对应拨到 00101（说明见附录，1 代表 ON，0 代表 OFF，

X 代表任意，即可以是 0 也可以是 1），这是 UART2 档位。RS232 串口线通过 USB

转串口接到 PC 机的 USB 口，DB9 母头（带孔）接底板 UART2 口，设置 PC 机调试终

端 COM 口，波特率为 115200，8N1，无检验位。推荐使用 ZOC 串口调试终端软件，

TMS320C6748 产品资料光盘的 tools 目录下有 ZOC 的安装包 zoc602.zip。   

 假如是使用 ZOC 的用户，依次点击菜 ZOC 单栏的 Options->Jump to->Devices，然

后选择 Serial/Modem。在 Serial/Modem 中扫描然后选择 COM 口，波特率为 115200，

8N1，无检验位，RTS signal off，DTR signal off，其它选项按默认设置。 

 开发板上电，即可在调试终端看到系统自动打印的 BOOTME 信息，说明开发板硬

件正常工作了。 

 

 

图 1 

 

1.2 查看仿真器驱动是否正常安装 

以 XDS100V2 仿真器为例，开发板断电，连接好仿真器和开发板，并将仿真器的 USB

口插进电脑 USB 插槽，开发板上电。右击计算机图标，点击设备->通用串行总线控制器，

查看是否有 TI XDS100 Channel A 和 TI XDS100 Channel B 选项出现，如有说明仿真器驱

动已经正常安装，否则请正常安装 XDS100V2 的驱动程序。 
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备注：请务必在安装 CCS 软件后，再检测仿真器驱动。 

 

 

图 2 

 

2  基于仿真器的程序加载和烧写 

2.1 设置工程配置文件信息 

新建"C\:TMS320C6748"目录，然后将光盘中 images目录下的C6478_NandWrite.out、

C6748AISgen_456M_config.cfg、TronLong_C6748.gel 文件复制到"C\:TMS320C6748"文件

夹。打开 CCS5.5，点击 View->Target Configrations，右边弹出如下对话框： 
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图 3 

 

 点击左边第一项，新建配置文件。 

 

 

图 4 

 

 输入工程名字：TMS320C6748.ccxml，点击 Finish。 
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图 5 

 

 在弹出的对话框中，Connection 选择 XDS100V2，Board or Device 选择 TMS320C6748，

点击右边的 Save 按钮。 

 

 

图 6 

 

2.2 测试仿真器是否正常连接 
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点击 Test connection，看是否提示成功连接，如下图。如提示错误，请检查开发板是

否上电、接线是否正常。 

 

 

图 7 

 

2.3 加载 GEL 文件 

 点击 Run->Debug，弹出以下界面。可以看到 C674X_0。  

 

 

图 8 

 

 右击 C674X_0 核，在弹出的界面中选择"Open GEL Files View"选项，右下角会弹出

GEL Files(TMS320C674X)对话框。 
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图 9 

 

 在对话框内点击右键，在弹出的界面中选择"Load GEL"。选择"C:\TMS320C6748\ 

TronLong_C6748.gel"文件后，点击确定，右下角的 GEL Files(TMS320C674X)对话框会出

现“Success”提示语句，如下图： 

 

 

图 10 

 

2.4 CCS 连接开发板 CPU 

 右击 C674X_0 核，选择 Connect Target 选项，会显示 Suspended 状态。这说明 CCS
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已经和开发板 CPU 正常连接起来了。 

 

 

图 11 

 

2.5 运行 GEL 文件来初始化开发板 

根据芯片主频，点击"Scripts->TronLong_DSP_C6748-> TronLong_C6748_456MHz"，

运行后会提示 Config Complete，开发板初始化完成。 

 GEL 文件的作用是在调试模式初始化硬件环境（DDR2、NAND FLASH 等），只有

加载了 GEL 文件后才会出现此菜单，只要开发板不断电 初始化操作只需要执行一次就

可以。 

 

 

图 12 
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图 13 

 

2.6 查看 CPU 版本号 

点击 View->Memory Browser,会出现 Memory Browser 窗口，在输入框中输入

0x11700000 并回车，选择“Character”可查询 TMS320C6748 核的版本号，CPU 版本号

在文件格式转换需用到；例如这里的 DSP 核版本号为：d800k008，如下图： 

 

 

图 14 

 

2.7 加载和运行程序 
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点击"Run->Load->Load Program"，选择"C:\TMS320C6748\C6478_NandWrite.out"文件，

点击 OK。接着点击绿色三角启动按键 。在 Console 窗口会有打印信息出现，

提示是否擦除 NAND FLASH。 

 

 

图 15 

 

备注：如果第一次操作没有出现 Console 窗口，请按黄色键暂停运行 ，然后按

重启键 复位 CPU，接着点击绿色三角启动按键 ，即可看到 Console 窗口

会有打印信息出现。 

2.8 基于仿真器烧写程序到 NAND FLASH 

 以 LED 为例，把光盘中 demo 整个目录文件拷贝到 C 盘 TMS320C6748 文件夹下（若

不存在请先建立此文件夹）。 

    在Console窗"[C674X_0] Do you want to global erase NAND FLASH?"行后面输入"y"，

按回车键进行擦除 NAND FLASH。擦除完后，会提示"Enter the binary AIS file name to 

flash (enter 'none' to skip) :"，在下一行空白处输入要烧写的 DSP 程序镜像 GPIO_LED.bin

路径"C:\TMS320C6748\demo\Application\GPIO_LED\Debug\GPIO_LED.bin"，并按回车键。

等待出现"NAND boot preparation was successful!"即烧写成功。烧写时间与文件大小有关，

一般可在 15 秒内烧写完毕。 

    烧写完 GPIO_LED.bin 镜像后，拔下开发板仿真器接口，将开发板的拨码开关 1~5

号对应拨到 01110 档位，设置从 NAND FLASH 启动，可以看到开发板 LED 流水灯效果。 
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图 16 

 

2.9 NAND FLASH 烧写格式镜像转换方法 

C6478_NandWrite.out 只支持.bin 格式镜像烧写，而 CCS 编译程序生成的镜像为.out

格式文件，需把.out 格式镜像转换为.bin 格式镜像才能进行烧写，有关格式转换步骤如下： 

（1） 打开 AIS 软件。 

 如果 AIS 是安装在默认路径，请双击"C:\AISgen_d800k008_Install_v1.13\AISgen for 

D800K008\AISgen_d800k008.exe"，弹出如下界面： 

 

 

图 17 
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（2） 点击"File->Load Configuration" ，弹出如下界面： 

 

 

图 18 

 

（3） 根据芯片主频选择"C:\TMS320C6748\C6748AISgen_456M_config.cfg"。在

"Device Type "选框中选择 CPU 对应的 CPU 版本号 d800k008，此版本号可根据前面

版本号查询操作得到。在"DSP Application File "处选择 CCS 编译后的.out 格式文件路

径在。在"AIS Output File "处输入需输出的.bin 格式文件的路径和名字。 

最后点击"Generate AIS"按键，启动格式转换，可生成可烧写的.bin 格式镜像，如

下图所示： 
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图 19 

 

3  基于串口的程序加载和烧写 

3.1  串口加载和烧写格式镜像转换方法 

有关串口烧写格式镜像转换方法如下（以 LED 程序为例）： 

（1） 打开 AIS 软件。 

 如果 AIS 是安装在默认路径，请双击"C:\AISgen_d800k008_Install_v1.13\AISgen for 

D800K008\AISgen_d800k008.exe"，弹出如下界面： 
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图 20 

 

（2） 点击"File->Load Configuration" ，弹出如下界面： 

 

 

图 21 

 

（3） 根据芯片主频选择"C:\TMS320C6748\C6748AISgen_456M_config.cfg"。在"Device 

Type "选框中选择 CPU 对应的 CPU 版本号 d800k008，此版本号可根据前面版本号查询
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操作得到。在 Boot Mode 下拉框选择 UART2 模式，在"DSP Application File "处选择 CCS

编译后的.out 格式文件路径在，在"AIS Output File "处输入需输出的.bin 格式文件的路径

和名字。 

最后点击"Generate AIS"按键，启动格式转换，生成.bin 格式镜像，此镜像可用于

串口加载和串口烧写。如下图所示： 

 

 

图 22 

 

3.2  程序加载和运行 

(1) 开发板设置。 

 将开发板的拨码开关 1~5 号对应拨到 00101（说明见附录，1 代表 ON，0 代表 OFF，

X 代表任意，即可以是 0 也可以是 1），这是 UART2 档位，然后将开发板上电。 

(2) 通过 UartHost 软件加载和运行程序。 
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 如果 AIS 是安装在默认路径，请双击"C:\AISgen_d800k008_Install_v1.13\AISgen for 

D800K008\ UartHost\ UartHost.exe"，弹出如下界面： 

 

 

图 23 

 

 选择转换好的程序镜像，串口名称根据实际情况修改，如下图所示： 

 

  

图 24 
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 点击开始，弹出如下界面： 

 

 

图 25 

 

 将开发板复位，程序会通过串口加载到 DDR2 中，然后自动运行。UartHost 打印信

息如下，同时可以看到底板的 LED 灯闪烁。 

 



 

销售邮箱：sales@tronlong.com                   技术邮箱：support@tronlong.com  

公司总机：020-8998-6280                     公司官网：www.tronlong.com     24/116 

DSP+ARM+FPGA 

三核主板方案领导者

者者 

 

图 26 

 

(3) 通过 slh_OMAP-L138 软件加载和运行程序。  

 也可以使用 slh_OMAP-L138 软件加载和运行程序。可以在光盘 tools 目录下找到

slh_OMAP-L138.exe 软件，将其拷贝到 C 盘根目录。在 Windows 开始菜单底部输入 cmd

进入控制台窗口（注意：COM 口和镜像路径参数需和实际一致，镜像路径为上面步骤产

生的.bin 格式文件路径），并执行加载命令，如下图所示： 

DOS# cd C:\ 

DOS# slh_OMAP-L138 -waitForDevice -p COM10 

C:\TMS320C6748\demo\Application\GPIO_LED\Debug\GPIO_LED.bin 

 



 

销售邮箱：sales@tronlong.com                   技术邮箱：support@tronlong.com  

公司总机：020-8998-6280                     公司官网：www.tronlong.com     25/116 

DSP+ARM+FPGA 

三核主板方案领导者

者者 

 

图 27 

 

 

图 28 

  

 将开发板复位，程序会通过串口加载到 DDR2 中，然后自动运行。Windows 控制台

窗口打印信息如下，同时可以看到底板的 LED 灯闪烁。 
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3.3  基于串口烧写程序到 NAND FLASH 

(1) 开发板设置。 

 将开发板的拨码开关 1~5 号对应拨到 00101（说明见附录，1 代表 ON，0 代表 OFF，

X 代表任意，即可以是 0 也可以是 1），这是 UART2 档位，然后将开发板上电。 

(2) 程序烧写。 

 在光盘 tools 目录下找到 sfh_OMAP-L138.exe 软件，将其拷贝到 C 盘根目录。在

Windows 开始菜单底部输入 cmd 进入控制台窗口，并执行烧写命令（注意：COM 口和

镜像路径参数需和实际的一致，镜像路径为上面步骤产生的.bin 格式文件路径），如下

图所示： 

DOS# cd C:\ 

DOS# sfh_OMAP-L138 -flash_noubl -targetType C6748 -flashType NAND -p COM10 

C:\TMS320C6748\demo\Application\GPIO_LED\Debug\GPIO_LED.bin 
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图 30 

 

 将开发板复位，程序会通过串口烧写到 NAND FLASH 中。Windows 控制台窗口打印

信息如下： 
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 将开发板的拨码开关 1~5 号对应拨到 01110，这是 NAND FLASH 启动档位，然后将

开发板上电，可以看到底板的 LED 灯闪烁。 

 在 Windows 控制台输入如下命令可以查看 sfh_OMAP-L138.exe 软件命令的所有用法。 

DOS# sfh_OMAP-L138.exe -h 
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4  CCS 工程新建和编译 

 为了更好的显示中文，请修改 Preferences 中 C++编译器字体大小及控制台字体，点

击 CCS 菜单"Windows->Preferences"，如下图所示： 

 



 

销售邮箱：sales@tronlong.com                   技术邮箱：support@tronlong.com  

公司总机：020-8998-6280                     公司官网：www.tronlong.com     30/116 

DSP+ARM+FPGA 

三核主板方案领导者

者者 

 

图 33 

 

 在弹出的界面中修改 C/C++ Editor Text Font 字体 为 12 号以上，如下图所示： 

 

 

图 34 
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4.1 新建工程 

 点击 CCS5 菜单的"File->NEW->Project->Code Composer Studio->CCS Project"，弹出

如下界面： 
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 然后点击 Next，弹出对话框，并修改为如下： 
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Project name: hello，CCS 工程名字； 

Family: C6000； 

Variant: C674x Floating-point DSP->TMS320C6748； 

Connection:XDS100v2，仿真器类型； 

 在"Empty Projects"下方选择"Empty Project(with main.c)"，点击 Finish 就可以完成工程

新建了，弹出如下界面： 
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图 38 

 

4.2 编写程序 

 编辑 main.c 文件，增加用户需要实现的功能代码，例如增加打印信息： 

 

#include<stdio.h> 

int main(void) { 

 printf("********Enjoy your TL6748-EVM!........www.tronlong.com********\n"); 

 return 0; 

} 

 编辑完成后如下图所示： 
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4.3 编译和运行程序 

 右击工程，在弹出来的对话框中点击"Build Project"，即可对当前工程编译，如下图： 

 

 

图 40 

 

 编译完毕后，可在左侧工程的 Binaries 下看到产生了可执行 hello.out 文件，如下图： 
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 在程序加载前，先按照前面章节步骤连接开发板并用 GEL 文件初始化 DSP 核，再点

击左上角的 load 键，选择要加载的 hello.out 文件。 

 

 

图 42 

 

 等待程序加载完成，然后点击 程序运行按钮，可以发现 CCS 的 Console 控制台有

程序中指定的信息打印出来，至此最简单的 DSP 裸机程序开发成功。 

 

 

图 43 
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 通过以上步骤，用户可以学习如何新建工程和在 CCS 下运行 DSP 程序了。 

5  CCS 工程导入和编译步骤 

（1） 将光盘中 demo 目录拷贝到"C:\TMS320C6748"，用户可以基于 demo 目录下的现

有工程直接编译和运行程序。点击 CCS 菜单"File->Import"，弹出以下对话框： 

 

 

图 44 

 

（2） 点击"Code Composer Studio->Existing CCS Eclipse Projects"后再点击 Next，如下

图所示： 
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（3） 在弹出的对话框的"Select search-directory"后面点击 Browse，选择 LED 的 CCS 工

程的存放路径" C:\TMS320C6748\demo\Application\GPIO_LED"，选择后如下图所示： 
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（4） 点击 Finish 就可以导入现有 CCS 工程。然后右击工程，在弹出来的对话框中点

击"Rebuild Project"，即可对当前工程编译，如下图： 
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（5） 编译完毕后，可在左侧工程的Binaries下看到产生了可执行GPIO_LED.out文件，

如下图： 

 

 

图 48 

 

（6） 开发板上电，点击"Run->Debug"，出现 Debug 界面，并发现 CPU 自动 Connect

了。 
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 此处使用的是工程中的.ccxml 文件，在 CPU 自动连接后，点击脚本初始化 CPU，如

下图所示： 

 

 

图 50 

 

（7） 再点击左上角的 load 键，选择要加载的 GPIO_LED.out 文件，如下图所示： 

 

 

图 51 
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 等待程序加载完成，然后点击 程序运行按钮，可以发现底板的 LED 流水灯执行了。

点击黄色的暂停键 ，再按 F5 会进去函数里面，按 F6 就单步走。 

6  Demo 例程演示 

6.1 GPIO_LED——LED 灯 GPIO 输出 

 此程序的作用是实现 GPIO 输出功能，工程位于光盘 demo\Application\GPIO_LED 目

录，按照工程导入步骤加载 GPIO_LED.out 文件，然后点击程序运行 按钮。 

演示现象 

（1） 核心板及底板 LED 循环点亮。 

6.2 GPIO_KEY——按键中断 GPIO 输入 

 此程序的作用是实现 GPIO 输入功能，工程位于光盘 demo\Application\GPIO_KEY 目

录，按照工程导入步骤加载 GPIO_KEY.out 文件，然后点击程序运行 按钮。 

演示现象 

（1） 按下 SW6 按键将标志 Flag 置 1 ，核心板 LED 开始循环点亮。 

（2） 按下 SW5 按键将标志 Flag 置 0 ，核心板 LED 停止循环点亮。 

6.3 TIMER——定时器 

 此程序的作用是实现定时器功能，此处使用的是定时器 2。DSP C6748 有 4 个定时器

/计数器，均可配置为 64 位计数器、两个独立 32 位计数器及自动重装 32 位计数器，可

以产生周期中断 DMA 事件及外部事件。定时器/计数器还可以用于捕获外部输入信号边

缘并计数。此外，定时器 1 还可以用作 64 位看门狗计数器。 
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 工程位于光盘 demo\Application\TIMER 目录，按照工程导入步骤加载 TIMER.out 文

件，然后点击程序运行 按钮。 

演示现象 

（1） 核心板 LED 定时循环点亮。 

 时钟为 PLL1_SYSCLK2=300MHz/2=150MHz，所以时间间隔为： 

0x0FFFFFFF/150000000= 1.7895697 S 

6.4 UART1_POLL——串口查询收发 

 此程序的作用是实 现串口 1 轮询方式数据收发功能， 工程位于光盘

demo\Application\UART1_POLL 目录，按照工程导入步骤加载 UART1_POLL.out 文件，

将开发板的 UART1 和 PC 机连接，打开 ZOC 串口调试终端，设置好波特率为 115200，

数据位 8 位，停止位 1 位，检验位无，流控制无，然后点击程序运行 按钮。 

演示现象 

（1） ZOC 串口调试终端会打印提示信息，此信息是由 DSP 发送出来的，如下图所示： 

 

 

图 52 

 

（2） 使用键盘输入任意字符，DSP 会将接收到的字符回显到 ZOC 串口调试终端，如

下图所示： 
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6.5 UART2_INT——串口中断收发 

 此程序的作用是实 现 串口 2 中断方式 数据收发功能， 工程位于光盘

demo\Application\UART2_INT 目录，按照工程导入步骤加载 UART2_INT.out 文件，将开

发板的 UART2 和 PC 机连接，打开 ZOC 串口调试终端，设置好波特率为 115200，数据

位 8 位，停止位 1 位，检验位无，流控制无，然后点击程序运行 按钮。 

演示现象 

（1） ZOC 串口调试终端会打印提示信息，此信息是由 DSP 发送出来的，如下图所示： 

 

 

图 54 

 

（2） 使用键盘输入任意字符，DSP 会将接收到的字符回显到 ZOC 串口调试终端，如

下图所示： 
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6.6 IIC_EEPROM——IIC EEPROM 读写 

 此程序的作用是实现 IIC EEPROM 设备的数据读写功能，工程位于光盘

demo\Application\IIC_EEPROM 目录，按照工程导入步骤加载 IIC_EEPROM.out 文件，将

开发板的 UART2 和 PC 机连接，打开 ZOC 串口调试软件，设置好波特率为 115200，数

据位 8 位，停止位 1 位，检验位无，流控制无，然后点击程序运行 按钮。 

演示现象 

（1） ZOC 串口调试终端会打印如下信息： 

 

 

图 56 
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 此程序先写入并读出一个字节数据，然后写入并读出一页数据，接着对比写入和读出

的数据，根据结果判断 IIC EEPROM 设备读写是否成功。 

6.7 SPI_FLASH——SPI FLASH 读写 

 此程序的作用是实现 SPI FLASH 设备的数据读写功能，此设备挂载在 SPI1 总线，工

程位于光盘 demo\Application\SPI_FLASH 目录，按照工程导入步骤加载 SPI_FLASH.out

文件，将开发板的 UART2 和 PC 机连接，打开 ZOC 串口调试软件，设置好波特率为 115200，

数据位 8 位，停止位 1 位，检验位无，流控制无，然后点击程序运行 按钮。 

演示现象 

（1） ZOC 串口调试终端会打印如下信息： 

 

 

图 57 

 

 此程序先提示是否擦除 SPI FLASH，输入 y 擦除 SPI FLASH 上的数据，然后对比写

入和读出的数据，根据结果判断 SPI FLASH 设备读写是否成功。 

6.8 WatchDog——看门狗 
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 此程序的作用是实现看门狗功能，看门狗定时器 1 用于在程序运行过程中出现错误或

陷入死循环等异常情况下复位程序。此程序设定看门狗超时时间为 5s。程序运行后在 5s

内输入任意字符，程序会持续运行，否则系统将复位。 

 工程位于光盘 demo\Application\WatchDog 目录，按照工程导入步骤加载

WatchDog.out 文件，将开发板的 UART2 和 PC 机连接，打开 ZOC 串口调试软件，设置

好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，流控制无，然后点击程序运

行 按钮。 

演示现象 

（1） 串口打印提示信息，在 5s 内无任何信息输入将复位系统。由于在仿真加载模式

下，复位后程序不会自动运行，故只会打印一次信息。若将程序烧写到 NAND FLASH

后，并在 NAND FLASH 档位启动系统，系统复位后程序会再次运行，将会持续打印

提示信息，如下图所示： 

 

 

图 58 

 

6.9 NMI——不可屏蔽中断 

 此程序的作用是实现不可屏蔽中断功能。NMI (Non Maskable Interrupt)——不可屏蔽
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中断(即 CPU 不能屏蔽)，无论状态寄存器中 IF 位的状态如何，CPU 收到有效的 NMI 必

须进行响应。工程位于光盘 demo\Application\NMI 目录，按照工程导入步骤加载 NMI.out

文件，然后点击程序运行 按钮。 

演示现象 

（1） 每按一下不可屏蔽中断按键（SW4），CPU 就响应 NMI 去将核心板的 LED 轮流

点亮。 

6.10 PWM——高精度脉冲宽度调制器 PWM 输出 

 此程序的作用是实现 eHRPWM（高精度脉冲宽度调制器）输出功能。TMS320C6748

共有两个 eHRPWM 模块，此处测试模块 1 的 EPWM1_A 引脚。由于使用 TL6748-EVM

测试 eHRPWM 不方便，因此此处使用 TL6748-EasyEVM 演示。 

 工程位于光盘 demo\Application\PWM 目录，按照工程导入步骤加载 PWM.out 文件，

然后点击程序运行 按钮。 

 用示波器探头测 TL6748-EasyEVM-A3 底板上的 J2 排针第 7 引脚（EPWM1_A），示

波器的地接在 SD 卡卡座上（地），如下图所示： 

 

 

图 59 
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图 60 

 

 

图 61 

 

 可在示波器上看到看到频率为 10kHz、占空比为 50%的方波，如下图所示： 

 

 

图 62 
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 可以通过修改程序中的函数 PWM1ABasic(10000,50)的参数，对 PWM 波输出的频率

和占空比进行修改，其中 10000 代表频率 10K，50 代表占空比 50%。也可以取消对

ChopperWaveform()的注释，在 EPWM1_A 管脚获得更高频率的斩波输出。 

6.11 ECAP_APWM——增强型捕获模块 ECAP 辅助输出 

 此程序的作用是实现 eCAP（增强型捕获模块）的 APWM（辅助脉冲宽度调制器）输

出功能。由于使用 TL6748-EVM 测试 eCAP 不方便，因此此处使用 TL6748-EasyEVM 演

示。 

 TMS320C6748 共有三个 eCAP 模块，此处测试模块 3 的 ECAP2_APWM2 引脚。可

在核心板引脚说明表中看到 ECAP2_APWM2 和 EPWMN0_TZ[0]引脚功能复用，如下图

所示： 

 

 

图 63 
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图 64 

 

 工程位于光盘 demo\Application\ECAP_APWM 目录，按照工程导入步骤加载

ECAP_APWM.out 文件，然后点击程序运行 按钮。 

 用示波器探头测 TL6748-EasyEVM-A3 底板上的 J2 排针第 3 引脚（ECAP2_APWM2），

示波器的地接在 SD 卡卡座上（地），可以在示波器上看到看到周期 10KHz、占空比为

50%的方波，如下图所示： 

 

 

图 65 

 

 通过修改Period和DutyCycle来改变频率和占空比。Period是比较器的数值，DutyCycle

是占空比。以下为 eCAP 输出频率计算公式： 
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（1） eCAP 模块频率=CPU 频率/2=456MHz/2=228MHz 

（2） eCAP 周期=1/（eCAP 模块频率）* Period=1/(228MHz)*22800 

（3） eCAP 输出频率= 1/ eCAP 周期=228MHz/22800=10KHz 

 可在程序中取消对#define SELECT_LED 注释，重新编译和加载程序，测试 GPIO0_0

引脚（和 ECAP1_APWM1 引脚复用），该引脚和底板 LED D7 灯为同一引脚，可以实现

通过 APWM 调节 LED D7 的亮灭（注意：APWM 波的输出频率不能设置太高，否则看

不到 LED 的变化）。 

6.12 PWM_ECAP——增强型捕获模块 ECAP 捕获 

 此程序的作用是实现 eCAP（增强型捕获模块）输入捕获功能，将 ECAP2_APWM2

设置为输入捕获模式，检测由 EPWM1_A 管脚输出的方波频率。由于使用 TL6748-EVM

测试不方便，因此此处使用 TL6748-EasyEVM 演示。 

 将 TL6748-EasyEVM-A3 底板上 J2 排针的第 3 和第 7 管脚短接，即将 EPWMN0_TZ[0]

（ECAP2_APWM2 和 EPWMN0_TZ[0]引脚功能复用）和 EPWM1_A 短接，如下图所示： 

 

 

图 66 

 

 工程位于光盘 demo\Application\PWM_ECAP 目录，按照工程导入步骤加载

PWM_ECAP.out 文件，将开发板的 UART2 和 PC 机连接，打开 ZOC 串口调试软件，设

置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，流控制无，然后点击程序
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运行 按钮。 

演示现象 

（1） ZOC 串口调试终端会分别打印 PWM 和 eCAP 产生和捕获到的相关参数，单位是

Hz，如下图所示。 

 

 

图 67 

 

 可以通过修改函数 PWM1ABasic(1000,50)的频率值，重新验证程序。 

 说明：PWM 模块输出频率有些偏差，但 ECAP 模块捕获到的 PWM 实际频率较为准

确。以下是 PWM 理论输出频率和实际输出频率的对比： 

 

 

图 68 

6.13 RTC——RTC 时钟 
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 此程序的作用是实现 RTC 计时功能，工程位于光盘 demo\Application\RTC 目录，按

照工程导入步骤加载 RTC.out 文件，将开发板的 UART2 和 PC 机连接，打开 ZOC 串口

调试软件，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，流控制无，

然后点击程序运行 按钮。 

演示现象 

（1） ZOC 串口调试终端会打印如下信息，请依次设定小时、分钟、秒、日、月、年，

程序就按照设定时间开始计时，并将实时时间打印出来，以此时间为例：17 点 23 分

00 秒，2014 年 6 月 7 日，星期六。 

 

 

图 69 

 

 

图 70 
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6.14 LCDC_GrLIB——LCD 显示 

 此程序的作用是实现 LCD 显示功能，程序会调用 grLib 图形库显示各种图形元素，

工 程 位 于 光 盘 demo\Application\LCDC_GrLIB 目 录 ， 按 照 工 程 导 入 步 骤 加 载

LCDC_GrLIB.out 文件，将开发板的 UART2 和 PC 机连接，打开 ZOC 串口调试软件，设

置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，流控制无，然后点击程序

运行 按钮。 

演示现象 

（1） ZOC 串口调试终端会打印如下信息： 

 

 

图 71 

 

（2） LCD 会显示图片。 

更改显示图像方法 

 准备好 bmp 格式图形文件（例如 tronlong.bmp），将其拷贝到 StarterWare 安装路径

中的 tools\bmp2c 目录下，若 StarterWare 为默认的安装路径，此目录的完整路径为

C:\ti\C6748_StarterWare_1_20_04_01\tools\bmp2c。 

 在 Windows 开始菜单底部输入 cmd 进入控制台窗口，进入此 bmp2c 目录并执行图片

转化命令，会生成图形文件的字符数组 C 文件 image.c，命令如下： 

DOS#  cd C:\ti\C6748_StarterWare_1_20_04_01\tools\bmp2c 

DOS# bmp2c -8 tronlong.bmp image.c 
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图 72 

 

 打开 image.c，在该文件头加入头文件申明“#include "grlib.h"”，如下图所示： 

 

 

图 73 

 

 最后把 image.c 文件拷贝至 LCDC_GrLIB 工程根目录下覆盖原有图像文件 image.c，

重新编译并运行程序即可。建议图片不能太大，否则会影响编译、加载、烧写的时间。 

6.15 MMCSD_ACCESS——SD 卡读写 

 此程序实现了通过 MMCSD0 接口对 SD 卡进行块数据读写。 
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注意：该测试会破坏 SD 卡原有的内容，破坏后将无法在 PC 机端识别 SD 卡，请在做测

试之前请做好数据备份工作。最好找个专门的 SD 卡做测试，因为暂时还没有 SD 卡恢复

的方法。 

 工程位于光盘 demo\Application\MMCSD_ACCESS 目录，按照工程导入步骤加载

MMCSD_ACCESS.out文件，将开发板的UART2和 PC机连接，打开 ZOC串口调试终端，

设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，流控制无，然后点击程

序运行 按钮。 

演示现象 

（1） ZOC 串口调试终端会打印提示信息，说明数据读写成功。 

 

 

图 74 

 

6.16 SATA——SATA 硬盘读写 

 Coming soon. 

6.17 USB_DEV_BULK——USB OTG 从方式（USB BULK 管道通信） 

此程序的作用是演示 USB 从方式，通过 USB BULK 管道实现主机和 TMS320C6748

开发板的数据交换。 

首先连接开发板的 USB OTG 和 PC 机 USB 接口，接着在 PC 机中安装 USB 驱动程

序，具体驱动程序是光盘 demo\host_app\USB_DEV_BULK\driver 下的 installer_x64.exe
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和 installer_x86.exe 两个文件。前者是 64 位 Windows 系统驱动，后者是 32 位 Windows 系

统驱动，双击安装，安装过程很短，一闪而过。（注意：在 64 位 Win7 系统下验证过，

其他操作系统请用户自行验证。） 

 工程位于光盘 demo\Application\USB_DEV_BULK 目录，按照工程导入步骤加载

USB_DEV_BULK.out 文件，将开发板的 UART2 和 PC 机连接，打开 ZOC 串口调试软件，

设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，流控制无，然后点击程

序运行 按钮。 

检查 PC 设备管理器中是否枚举到 USB 设备 General Bulk Device，如下图所示。 

 

图 75 

 

如果显示为“Generic Bulk Device”或者未知设备设备。请右击此设备，在弹出的菜

单中选择“更新驱动程序软件”，如下图所示：  

 

 

图 76 
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 在弹出的界面中选择“浏览计算机以查找驱动程序软件”，如下图所示： 

 

图 77 

 

 在弹出的界面中选择光盘“demo\host_app\USB_DEV_BULK\driver”路径，然后点击

下一步： 

 

 

图 78 
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 弹出如下界面，点击安装。 

 

 

图 79 

 

 安装成功会弹出如下界面。 

 

 

图 80 
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 将 demo\host_app\USB_DEV_BULK 下的测试程序源码 usb_bulk_test 整个目录复制到

C 盘根目录下，在 Windows 开始菜单底部输入 cmd 进入控制台窗口，进入此 usb_bulk_test

下的 debug 目录并执行测试程序，命令如下： 

DOS#  cd C:\usb_buk_test\debug 

DOS# usb_buk_test.exe 

演示现象 

（1） PC 机控制台窗口显示读写数据成功信息。 

 

 

图 81 

 

（2） ZOC 窗口输出提示信息。 
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图 82 

 

（3） 屏幕提示开发板和 PC 通信成功，并显示已成功传输字节数量。 

UI 程序演示  

 为了方便使用，TMS320C6748 开发板的光盘中提供了一个 UI 程序。 

 源码和可执行程序分别位于如下路径： 

demo\host_app\USB_DEV_BULK\bulk_test_ui 

demo\host_app\USB_DEV_BULK\bulk_test_ui\debug\bulk_test_ui.exe 

 双击可执行程序 bulk_test_ui.exe（如果执行有错误，请使用 VS2005 重新编译并生

成.exe 文件），弹出如下界面： 

 

 

图 83 
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 点击“打开设备”，然后点击“读写设备”，界面显示如下： 

 

 

图 84 

  

 UI 程序将十六进制数据 00~3f 共 64 个数据通过 USB 送往开发板，然后再读取回来，

显示在 UI 界面上。 

USB Tracer 捕获工具的使用 

 为了更清楚的是看到 USB 数据的传输，可以使用 USBTrace 工具。USBTrace 是一款

功能强大的USB监控软件，它能够分析USB总线和与之相连的USB设备的的连接状况，

监控包括 USB 控制器，USB 集线器和 USB 设备的连接，请求和运行情况。具备 USB 包

抓取，USB 设备类别分析等功能，适合检测主机方的 USB 控制协议。 

 该工具在 demo\host_app\tools\USBTrace_Installer目录下，先安装原程序，然后将Crack

目录下的所有内容覆盖到安装目录中。 

USBTrace_x64_Build_77_220512_Installer：64 位 

USBTrace_x86_Build_77_220512_Installer：32 位 

 确保开发板正常启动、USB 驱动已正常安装、UI 正常启动，然后点击桌面的 USBTrace

图标，弹出如下界面： 
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 选择需要捕获的 USB 设备“Generic Bulk Device”，如下图所示： 

 

 

图 86 

 

设置过滤器并开始捕获，点击步骤按照 1->2->3->4->5，如下图所示： 
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 然后点击 bulk_test_ui 界面的“读写设备”按钮，可发现 USBTrace 右边显示如下图： 

 

 

图 88 

  

 点击 OUT 或者 IN 行即可在下方看到发送或者接收到的数据，如下图所示： 
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图 89 

 

6.18 USB_DEV_MSC——USB OTG 从方式（虚拟存储设备） 

此程序的作用是演示 USB 从方式，将 TMS320C6748 开发板模拟成一个 USB 存储设

备，实现主机和开发板之间的数据传输。 

 工程位于光盘 demo\Application\USB_DEV_MSC 目录，按照工程导入步骤加载

USB_DEV_MSC.out 文件，连接开发板的 USB OTG 和 PC 机 USB 接口，然后点击程序

运行 按钮，弹出如下格式化提示界面： 

 

 

图 90 

 

点击“格式化磁盘”，弹出如下界面： 

 



 

销售邮箱：sales@tronlong.com                   技术邮箱：support@tronlong.com  

公司总机：020-8998-6280                     公司官网：www.tronlong.com     67/116 

DSP+ARM+FPGA 

三核主板方案领导者

者者 

 

图 91 

  

 点击“开始”，弹出如下界面： 

 

 

图 92 

  

 点击“确定”，弹出如下界面： 
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 可以在 PC 中看到新产生约 48MByte 大小的可移动磁盘，如下图所示： 

 

 

图 94 

 

可以像操作普通的 U 盘一样操作此磁盘。请保持开发板状态和连接，进行如下速度

测试步骤。 

传输速度测试 

双击光盘中 tools 目录下的 ATTO Disk Benchmarks V2.47_CN.exe 文件，弹出如下界

面。选择磁盘（此处识别为 I 盘），选择 32MByte 空间，然后点击“开始”按钮： 
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图 95 

 

 等待 3 分钟左右，可以在界面中看到 0.5KByte~8MByte 文件读写速度测试结果，如

下图所示： 
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图 96 

 

 可从图中看到当传输文件达到 64KByte 以上，读和写速度可以分别稳定在 24MByte/S

和 23MByte/S 左右。 

6.19 USB_DEV_SERIAL——USB OTG 从方式（USB 虚拟串口） 

 此程序的作用是演示 USB 从方式，实现 USB 虚拟串口功能。工程位于光盘

demo\Application\USB_DEV_SERIAL 目 录 ， 按 照 工 程 导 入 步 骤 加 载

USB_DEV_SERIAL.out 文件，通过 OTG 将开发板和 PC 机 USB 接口连接，将开发板的

UART2 和 PC 机连接，打开 ZOC 串口调试软件，设置好波特率为 115200，数据位 8 位，

停止位 1 位，检验位无，流控制无，然后点击程序运行 按钮。 

 可以发现识别为 USB 为虚拟串口，如下图所示： 
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图 97 

 

 若无法识别，请仿照 USB_DEV_BULK 相关步骤手动更新驱动，驱动位于资料光盘

tools/USB_DEV_SERIAL_DRIVER 目录下。由于 ZOC 无法识别大编号串口，请在设备->

端口中右击虚拟设备，弹出如下界面： 

 

 

图 98 

 

 点击“属性”，弹出如下界面： 
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点击“端口设置->高级”，如下图所示：  

 

 

图 100 
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 弹出如下界面，在“COM 端口号（P）”处选择一个空闲的 COM 口，然后点击确定。 

 

 

图 101 

 

 打开一个新的 ZOC 窗口，选择上面空闲的 COM 口，设置好波特率为 115200，数据

位 8 位，停止位 1 位，检验位无，流控制无。在任意一个窗口输入字符，可以在另外一

个窗口看到字符输出。 

 

 

图 102 
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6.20 USB_HOST_MSC——USB OTG 主方式（U 盘内容查看） 

 此程序的作用是演示 USB HOST 方式，实现 TMS320C6748 开发板对 U 盘的查看。

工程位于光盘 demo\Application\USB_HOST_MSC 目录，按照工程导入步骤加载

USB_HOST_MSC.out 文件，通过 OTG 转接头将 U 盘接到开发板的 OTG 接口，将开发

板的 UART2 和 PC 机连接，打开 ZOC 串口调试软件，设置好波特率为 115200，数据位

8 位，停止位 1 位，检验位无，流控制无，然后点击程序运行 按钮。 

 若在 ZOC 调试终端有打印信息“Mass storage device connected.”，说明 CPU 已发现

U 盘并连接成功，如下图所示： 

 

 

图 103 

 

 此处串口作用类似于 Linux 的串口终端后台，输入“h”并回车可查看已实现的后台

命令，如下图所示： 

 

 

图 104 
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ls：查看 U 盘内容 

chdir：改变目录路径 

cd：进入目录 

pwd：打印当前目录路径 

cat：查看文件内容 

 例如输入“ls”，可查看到 U 盘内容，如下图所示： 

 

 

图 105 

 

6.21 ENET_HTTPD——网络 WEB 服务器 

 此程序的作用是实现网络通信功能，在 TMS320C6748 开发板上搭建一个轻量级 WEB

服务器。连接接好网线（注意：接路由器用直连网线，直连 PC 则用交叉网线），将开发

板的 UART2 和 PC 机连接，打开 ZOC 串口调试软件，设置好波特率为 115200，数据位

8 位，停止位 1 位，检验位无，流控制无。工程位于光盘 demo\Application\ENET_HTTPD
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目录，按照工程导入步骤加载 ENET_HTTPD.out 文件，然后点击程序运行 按钮。 

演示现象 

（1） 串口显示开发板的 IP 地址（192.168.1.200）。 

 

 

图 106 

 

（2） 在 Windows 开始菜单底部输入 cmd 进入控制台窗口，执行 ping 命令，确认开发

版网络部分工作正常。 

DOS#  ping 192.168.1.200 
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（3） 打开浏览器输入网址 http://192.168.1.200，就可以看到网址内容。 

 

 

图 108 

 

6.22 ENET_ECHO——网络 Socket 通信 

 本程序主要演示 Socket 通信，开发板为服务器，PC 机为客户端，两者实现数据交换。

http://192.168.1.200/
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 首先连接好网线，连接接好网线（注意：接路由器用直连网线，直连 PC 则用交叉网

线），将开发板的 UART2 和 PC 机连接，打开 ZOC 串口调试软件，设置好波特率为 115200，

数据位 8 位，停止位 1 位，检验位无，流控制无。 

 工程位于光盘 demo\Application\ENET_ECHO 目录，按照工程导入步骤加载

ENET_ECHO.out 文件，然后点击程序运行 按钮。 

演示现象 

（1） 串口显示开发板的 IP 地址（192.168.1.200）和端口（2000），如下图所示： 

 

 

图 109 

  

UI 程序演示  

 首先在 Windows 开始菜单底部输入 cmd 进入控制台窗口，执行 ping 命令，确认开发

版网络部分工作正常。 

DOS#  ping 192.168.1.200 
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 接着双击 demo\host_app\ENET_ECHO\enet_client\debug\enet_client.exe 即可运行 UI

程序，弹出如下界面： 

 

 

图 111 

 

 UI 程序可以选择单次发收，也可以选择多次发收，发送的数据内容用户可以在程序

中自行修改，程序会对发送和接收的内容进行比对校验。点击“建立连接”后再点击“读

写测试”，弹出如下界面：  
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Wireshark 捕获工具的使用 

 

 Wireshark 是一个网络封包分析软件。网络封包分析软件的功能是撷取网络封包，并

尽可能显示出最为详细的网络封包资料。 

 Wireshark 软件的路径位于 demo\host_app\tools\Wireshark-win32-1.10.3.exe，请双击安

装此软件。正确安装后打开 Wireshark 软件，如下图所示： 

 

http://baike.baidu.com/view/6102086.htm
http://baike.baidu.com/view/37.htm
http://baike.baidu.com/view/6102086.htm
http://baike.baidu.com/view/37.htm
http://baike.baidu.com/view/6102086.htm
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 接着按下图步骤 1->2->3 点击，如下图所示： 
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图 114 

 

 点击 Start 后，弹出如下界面： 

 

 

图 115 

 然后按下图步骤1->2->3点击并在步骤 2中设置需要监控的 IP地址为 192.168.1.200，

如下图所示： 
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 点击 OK 后弹出如下界面： 

 

 

图 117 

 

 然后点击 UI 程序中的“读写测试”按钮或者在 PC 中执行“ping 192.168.1.200”命

令，Wireshark 会打印监听到的信息，如下图所示： 
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图 119 

 

6.23 AUDIO_PLAY——Line Out 音频输出 
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 此程序的作用是实现 Line out 音频播放功能，主要演示如何设置 MCASP 和 AIC 芯片

来播放一段原始音频数据。工程位于光盘 demo\Application\AUDIO_PLAY 目录，按照工

程导入步骤加载 AUDIO_PLAY.out 文件，将开发板的 UART2 和 PC 机连接，打开 ZOC

串口调试软件，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，流控制

无，然后点击程序运行 按钮，在 Line out 接口插上耳机。 

演示现象 

（1） ZOC 串口调试终端会打印如下信息： 

 

 

图 120 

 

（2） 耳机重复播放一段声音。 

6.24 AUDIO_MIC_IN——Mic In 音频输入 

 此程序的作用是将从 Mic In 接口输入的音频数据送到 Line Out 接口播放。工程位于

光盘demo\Application\AUDIO_MIC_IN目录，按照工程导入步骤加载AUDIO_MIC_IN.out

文件，将开发板的 UART2 和 PC 机连接，在 Line Ou CON11 接口插上耳机或者喇叭，在

Mic In CON10 接口插上 QQ 聊天使用的麦克风，打开 ZOC 串口调试软件，设置好波特率

为 115200，数据位 8 位，停止位 1 位，检验位无，流控制无，然后点击程序运行 按钮。 

演示现象 

（1） ZOC 串口调试终端会打印如下信息： 
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（2） 对着麦克风说话的时候，可以在耳机或者喇叭听到声音。 

6.25 AUDIO_LINE_IN——Line In 音频输入 

 此程序的作用是将从 Line In 接口输入的音频数据送到 Line Out 接口播放。工程位于

光 盘 demo\Application\AUDIO_LINE_IN 目 录 ， 按 照 工 程 导 入 步 骤 加 载

AUDIO_LINE_IN.out 文件，将开发板的 UART2 和 PC 机连接，在 Line Out CON11 接口

插上耳机或者喇叭。准备一条 3.5mm 两头均为公头的音频线，一头接着开发板的 Line In 

CON18 音频口，另外一端接在播放着歌曲的播放器（手机或者 PC 均可）。打开 ZOC 串

口调试软件，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，流控制无，

然后点击程序运行 按钮。 

演示现象 

（1） ZOC 串口调试终端会打印如下信息： 

 

 

图 122 

 

（2） 可以在耳机或者喇叭听到播放器播放的声音。 
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6.26 MCBSP_AD7606——MCBSP 总线 8 通道并口 AD 数据采集 

 Coming soon. 

6.27 VPIF_OV2640——VPIF 总线 CMOS 摄像头数据采集 

 此程序实现了使用 VPIF 总线去采集 OV2640 摄像头模组的数据并显示在 LCD 上。O

更多 OV2640 的信息请查阅创龙 CMOS 摄像头模块 TL2640 规格书。 

 工程位于光盘 demo\Application\VPIF_OV2640 目录，按照工程导入步骤加载

VPIF_OV2640.out 文件，将开发板的 UART2 和 PC 机连接。将 TL2640 模块插到开发板

底板的 J3 接口。切勿连接到底板 J2 接口，否则可能会烧坏模块，同时检查是否左右偏

移。连接如下图所示： 

 

 

图 123 

 

 打开 ZOC 串口调试软件，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验

位无，流控制无，然后点击程序运行 按钮。 

演示现象 
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（1） 串口打印 CMOS 摄像头 ID 信息，如下图所示： 

 

 

图 124 

 

（2） LCD 上会显示采集到的图像。 

6.28 EMIF_AD7606——EMIF 总线 8 通道并口 AD 数据采集 

 此程序实现了使用 EMIF 总线去读写 AD7606 AD 芯片。AD7606 是 8 通道、16Bit、

200K 采样率的 AD 芯片，支持并口/串口读写方式，模块默认为并口模式，采用并口模式

采样率可到达 200K 的采样率，采用 SPI 模式采样率只有 100K 左右。强烈建议使用并口

模式，这样才能真正发挥 8 通道 AD7606 的同步采样性能。支持±10V 或±5V 的双极性信

号输入，在电力、仪器仪表等行业应用广泛。更多信息请参考创龙 AD7606 数据采集模

块 TL7606 规格书。 

  通过AD7606数据采集模块TL7606的 J1的跳帽设置输入电压的范围为±10V或±5V。

接 0 设置范围为±5V，接 1 设置范围为±10V。电路图如下： 
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图 125 J1 连接器引脚定义 

 

   

（1） 连接开发板 

  将 TL7606 模块插到开发板底板的 J2 接口，如下图所示。切勿连接到底板 J3 接口，

否则会烧坏模块，同时检查是否左右偏移。 

 

 

图 126 

 

（2） 接入电压信号和供电电源 

 将需要采集的电压信号接到对应通道,另一端接到对应的地，例如接到 V1 和 V1GND。 

上层信号：V1、V2、V3、V4、V5、V6、V7、V8（按顺序从左到右）； 

下层信号：V1GND、V2GND、V3GND、V4GND、V5GND、V6GND、V7GND、V8GND

（按顺序从左到右）。 

 同时使用 5V 2A 电源适配器给模块供电。如下图所示： 
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  注意：输入电压不能超出已设置的电压范围，否则可能会损坏模块。此处为了测试方

便，地只接了 1 个通道的地，8 个通道的地内部是连通的，也将 8 个通道的输入端同时接

到了同一个数字输入电源。 

（3） 启动开发板 

 工程位于光盘 demo\Application\EMIF_AD7606 目录，按照工程导入步骤加载

EMIF_AD7606.out 文件，将开发板的 UART2 和 PC 机连接，打开 ZOC 串口调试软件，

设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，流控制无，然后点击程

序运行 按钮。 

（4） 读取 AD 采样值 

 串口终端会有类似如下的信息打印出来。 
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图 128 

 

理论值计算方法 

  例如输入 2.0V 时，得到的理论值： 

Value=32768*2.0/5.0=13107 

  如需 C6748 与 FPGA 通过 EMIF 通信的源程序和参考设计电路，见与 C6748 配套的

FPGA 高速数据采集板卡光盘资料。 

6.29 uPP——uPP 数据收发 

 如需 C6748 与 FPGA 通过 uPP 接口通信的源程序和参考设计电路，见与 C6748 配套

的 FPGA 高速数据采集板卡光盘资料。 

6.30 FFT——快速傅里叶变换/逆变换（不开缓存） 

 此程序的作用是实现 FFT 处理功能。工程位于光盘 demo\Application\FFT 目录，按照

工程导入步骤加载 FFT.out 文件，然后点击程序运行 按钮。 

 CCS 支持绘制多种类型的图表 时域图、频域图、瀑布图等等。待测试信号为原始信

号做 1K 采样频率进行 1024 个点抽样得到。 

信号源公式：y=5*sin(2*pi*150*t)+15*sin(2*pi*350*t) 

 该信号含有 150HZ和 350HZ 两种频率分量。 
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演示步骤现象 

 点击"Tools->Graph->Single Time"选择单时域信号图，如下图所示： 

 

 

图 129 

 

 按照下图进行设置。 
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图 130 

 

点击 OK，CCS 界面底部弹出如下界面： 
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图 131 

 

 MATLAB 代码 FFT.m 位于光盘 demo\Application\FFT，程序如下图： 

 

 

图 132 
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 MATLAB 图表如下图： 

 

 

图 133 

 

 经对比可以看出 CCS ，经过 DSP C6748 计算结果与 MATLAB 计算结果一致。 

6.31 FFT_Benchmark——快速傅里叶变换/逆变换（打开/关闭缓存速度对比） 

 此程序的作用是测试快速傅里叶变换/快速傅里叶逆变换处理速度。工程位于光盘

demo\Application\FFT_Benchmark 目录，按照工程导入步骤加载 FFT_Benchmark.out 文件，

打开 ZOC 串口调试软件，设置好波特率为 115200，数据位 8 位，停止位 1 位，检验位无，

流控制无，然后点击程序运行 按钮。 

信号源公式：y=2+3cos(2pi*50t-(30/180)pi)+1.5cos(2pi*75t+*(90/180)pi) 

演示现象 

（1） 串口会打印测试结果。 

Test signal 
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-Include 2V DC Component 

-Include 3V AC Component,Frequency:50Hz Phase:-30 Degree 

-Include 1.5V AC Component,Frequency:75Hz Phase:90 Degree 

-Formula:y=2+3cos(2pi*50t-(30/180)pi)+1.5cos(2pi*75t+*(90/180)pi) 

-------------------------------------------------- 

1: 8 Times FFT Test 

-Sampling Period:1s Sampling Frequency:8Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:54740 

-Forward Transformation Execution Time is 120 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:19340 

-Inverse Transformation Execution Time is 42 us (CPU Frequency:456MHz) 

8 Times FFT Test End 

-------------------------------------------------- 

2: 16 Times FFT Test 

-Sampling Period:1s Sampling Frequency:16Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:87584 

-Forward Transformation Execution Time is 192 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:36768 

-Inverse Transformation Execution Time is 80 us (CPU Frequency:456MHz) 

16 Times FFT Test End 

-------------------------------------------------- 

3: 32 Times FFT Test 

-Sampling Period:1s Sampling Frequency:32Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:178080 

-Forward Transformation Execution Time is 390 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:76528 

-Inverse Transformation Execution Time is 167 us (CPU Frequency:456MHz) 

32 Times FFT Test End 
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-------------------------------------------------- 

4: 64 Times FFT Test 

-Sampling Period:1s Sampling Frequency:64Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:359296 

-Forward Transformation Execution Time is 787 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:156756 

-Inverse Transformation Execution Time is 343 us (CPU Frequency:456MHz) 

64 Times FFT Test End 

-------------------------------------------------- 

5: 128 Times FFT Test 

-Sampling Period:1s Sampling Frequency:128Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:736104 

-Forward Transformation Execution Time is 1614 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:331420 

-Inverse Transformation Execution Time is 726 us (CPU Frequency:456MHz) 

128 Times FFT Test End 

-------------------------------------------------- 

6: 256 Times FFT Test 

-Sampling Period:1s Sampling Frequency:256Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:1475636 

-Forward Transformation Execution Time is 3236 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:666976 

-Inverse Transformation Execution Time is 1462 us (CPU Frequency:456MHz) 

256 Times FFT Test End 

-------------------------------------------------- 

7: 512 Times FFT Test 

-Sampling Period:1s Sampling Frequency:512Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:2967564 



 

销售邮箱：sales@tronlong.com                   技术邮箱：support@tronlong.com  

公司总机：020-8998-6280                     公司官网：www.tronlong.com     98/116 

DSP+ARM+FPGA 

三核主板方案领导者

者者 
-Forward Transformation Execution Time is 6507 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:1377836 

-Inverse Transformation Execution Time is 3021 us (CPU Frequency:456MHz) 

512 Times FFT Test End 

-------------------------------------------------- 

8: 1024 Times FFT Test 

-Sampling Period:1s Sampling Frequency:1024Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:5779008 

-Forward Transformation Execution Time is 12673 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:2727140 

-Inverse Transformation Execution Time is 5980 us (CPU Frequency:456MHz) 

1024 Times FFT Test End 

-------------------------------------------------- 

9: 2048 Times FFT Test 

-Sampling Period:1s Sampling Frequency:2048Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:11689464 

-Forward Transformation Execution Time is 25634 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:5711332 

-Inverse Transformation Execution Time is 12524 us (CPU Frequency:456MHz) 

2048 Times FFT Test End 

-------------------------------------------------- 

10: 4096 Times FFT Test 

-Sampling Period:1s Sampling Frequency:4096Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:23317528 

-Forward Transformation Execution Time is 51134 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:11448140 

-Inverse Transformation Execution Time is 25105 us (CPU Frequency:456MHz) 

4096 Times FFT Test End 
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-------------------------------------------------- 

11: 8192 Times FFT Test 

-Sampling Period:1s Sampling Frequency:8192Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:47896632 

-Forward Transformation Execution Time is 105036 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:24190248 

-Inverse Transformation Execution Time is 53048 us (CPU Frequency:456MHz) 

8192 Times FFT Test End 

-------------------------------------------------- 

12: 16384 Times FFT Test 

-Sampling Period:1s Sampling Frequency:16384Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:95890300 

-Forward Transformation Execution Time is 210285 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:48497568 

-Inverse Transformation Execution Time is 106354 us (CPU Frequency:456MHz) 

16384 Times FFT Test End 

-------------------------------------------------- 

13: 32768 Times FFT Test 

-Sampling Period:1s Sampling Frequency:32768Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:196861032 

-Forward Transformation Execution Time is 431712 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:102089868 

-Inverse Transformation Execution Time is 223881 us (CPU Frequency:456MHz) 

32768 Times FFT Test End 

-------------------------------------------------- 

14: 65536 Times FFT Test 

-Sampling Period:1s Sampling Frequency:65536Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:394094868 
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-Forward Transformation Execution Time is 864243 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:204606164 

-Inverse Transformation Execution Time is 448697 us (CPU Frequency:456MHz) 

65536 Times FFT Test End 

-------------------------------------------------- 

15: 131072 Times FFT Test 

-Sampling Period:1s Sampling Frequency:131072Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:809104740 

-Forward Transformation Execution Time is 1774352 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:430023512 

-Inverse Transformation Execution Time is 943034 us (CPU Frequency:456MHz) 

131072 Times FFT Test End      

 

 以上是没有使能 L1、L2 缓存的测试结果。可以看到测试 128K 点正变换执行时间为

1774352 us ，逆变换执行时间为 943034 us。 

 将以下代码去注释，就打开缓存了。 

 

 

图 134 

 

 重新编译和测试的数据如下： 

 

Test signal 

-Include 2V DC Component 

-Include 3V AC Component,Frequency:50Hz Phase:-30 Degree 

-Include 1.5V AC Component,Frequency:75Hz Phase:90 Degree 
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者者 
-Formula:y=2+3cos(2pi*50t-(30/180)pi)+1.5cos(2pi*75t+*(90/180)pi) 

-------------------------------------------------- 

1: 8 Times FFT Test 

-Sampling Period:1s Sampling Frequency:8Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:15464 

-Forward Transformation Execution Time is 33 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:4360 

-Inverse Transformation Execution Time is 9 us (CPU Frequency:456MHz) 

8 Times FFT Test End 

-------------------------------------------------- 

2: 16 Times FFT Test 

-Sampling Period:1s Sampling Frequency:16Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:18840 

-Forward Transformation Execution Time is 41 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:6556 

-Inverse Transformation Execution Time is 14 us (CPU Frequency:456MHz) 

16 Times FFT Test End 

-------------------------------------------------- 

3: 32 Times FFT Test 

-Sampling Period:1s Sampling Frequency:32Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:38388 

-Forward Transformation Execution Time is 84 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:13868 

-Inverse Transformation Execution Time is 30 us (CPU Frequency:456MHz) 

32 Times FFT Test End 

-------------------------------------------------- 

4: 64 Times FFT Test 

-Sampling Period:1s Sampling Frequency:64Hz Frequency Resolution:1Hz 



 

销售邮箱：sales@tronlong.com                   技术邮箱：support@tronlong.com  

公司总机：020-8998-6280                     公司官网：www.tronlong.com     102/116 

DSP+ARM+FPGA 

三核主板方案领导者

者者 
-Forward Transformation Execution Cycle is 0:78372 

-Forward Transformation Execution Time is 171 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:29220 

-Inverse Transformation Execution Time is 64 us (CPU Frequency:456MHz) 

64 Times FFT Test End 

-------------------------------------------------- 

5: 128 Times FFT Test 

-Sampling Period:1s Sampling Frequency:128Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:157980 

-Forward Transformation Execution Time is 346 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:59936 

-Inverse Transformation Execution Time is 131 us (CPU Frequency:456MHz) 

128 Times FFT Test End 

-------------------------------------------------- 

6: 256 Times FFT Test 

-Sampling Period:1s Sampling Frequency:256Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:317304 

-Forward Transformation Execution Time is 695 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:121664 

-Inverse Transformation Execution Time is 266 us (CPU Frequency:456MHz) 

256 Times FFT Test End 

-------------------------------------------------- 

7: 512 Times FFT Test 

-Sampling Period:1s Sampling Frequency:512Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:636200 

-Forward Transformation Execution Time is 1395 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:245552 

-Inverse Transformation Execution Time is 538 us (CPU Frequency:456MHz) 
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512 Times FFT Test End 

-------------------------------------------------- 

8: 1024 Times FFT Test 

-Sampling Period:1s Sampling Frequency:1024Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:1274796 

-Forward Transformation Execution Time is 2795 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:493316 

-Inverse Transformation Execution Time is 1081 us (CPU Frequency:456MHz) 

1024 Times FFT Test End 

-------------------------------------------------- 

9: 2048 Times FFT Test 

-Sampling Period:1s Sampling Frequency:2048Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:2555388 

-Forward Transformation Execution Time is 5603 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:993012 

-Inverse Transformation Execution Time is 2177 us (CPU Frequency:456MHz) 

2048 Times FFT Test End 

-------------------------------------------------- 

10: 4096 Times FFT Test 

-Sampling Period:1s Sampling Frequency:4096Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:5126152 

-Forward Transformation Execution Time is 11241 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:2005052 

-Inverse Transformation Execution Time is 4397 us (CPU Frequency:456MHz) 

4096 Times FFT Test End 

-------------------------------------------------- 

11: 8192 Times FFT Test 

-Sampling Period:1s Sampling Frequency:8192Hz Frequency Resolution:1Hz 
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-Forward Transformation Execution Cycle is 0:10399768 

-Forward Transformation Execution Time is 22806 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:4193816 

-Inverse Transformation Execution Time is 9196 us (CPU Frequency:456MHz) 

8192 Times FFT Test End 

-------------------------------------------------- 

12: 16384 Times FFT Test 

-Sampling Period:1s Sampling Frequency:16384Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:21118060 

-Forward Transformation Execution Time is 46311 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:8459340 

-Inverse Transformation Execution Time is 18551 us (CPU Frequency:456MHz) 

16384 Times FFT Test End 

-------------------------------------------------- 

13: 32768 Times FFT Test 

-Sampling Period:1s Sampling Frequency:32768Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:45652444 

-Forward Transformation Execution Time is 100115 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:20545012 

-Inverse Transformation Execution Time is 45054 us (CPU Frequency:456MHz) 

32768 Times FFT Test End 

-------------------------------------------------- 

14: 65536 Times FFT Test 

-Sampling Period:1s Sampling Frequency:65536Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:107256472 

-Forward Transformation Execution Time is 235211 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:56478452 

-Inverse Transformation Execution Time is 123856 us (CPU Frequency:456MHz) 
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65536 Times FFT Test End 

-------------------------------------------------- 

15: 131072 Times FFT Test 

-Sampling Period:1s Sampling Frequency:131072Hz Frequency Resolution:1Hz 

-Forward Transformation Execution Cycle is 0:218435484 

-Forward Transformation Execution Time is 479025 us (CPU Frequency:456MHz) 

-Inverse Transformation Execution Cycle is 0:116858320 

-Inverse Transformation Execution Time is 256268 us (CPU Frequency:456MHz) 

131072 Times FFT Test End                           

 

 以上是使能 L1、L2 缓存的测试结果。可以看到测试 128K 点正变换执行时间为 479025 

us ，逆变换执行时间为 256268us。 

6.32 FIR——有限长单位冲激响应滤波器 

 此程序的作用是进行 FIR 有限长单位冲激响应滤波器测试。工程位于光盘

demo\Application\FIR 目录，按照工程导入步骤加载 FIR.out 文件，然后点击程序运行

按钮，程序会在断点处停下来。 

 点击 CCS 菜单“Tools->Graph->Single Time”，在弹出的界面中按下图数值设置参数。 
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图 135 

 

 点击 OK 即可查看原始时域信号+噪声波形，如下图所示： 
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图 136 

 

 点击 CCS 菜单“Tools->Graph->Single Time”，在弹出的界面中按下图数值设置参数。 
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图 137 

 

 点击 OK 即可查看滤波后时域信号波形，如下图所示： 
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图 138 

 

 点击 CCS 菜单“Tools->Graph->Magnitude”，在弹出的界面中按下图数值设置参数。 
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图 139 

 

 点击 OK 即可查看原始频域信号+噪声波形，如下图所示： 
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图 140 

 

 点击 CCS 菜单“Tools->Graph->Magnitude”，在弹出的界面中按下图数值设置参数。 
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图 141 

 

 点击 OK 即可查看滤波后频域信号波形，如下图所示： 
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图 142 

 

Matlab FIR 滤波器辅助设计 

 安装并打开 Matlab R2013a，打开“Filter Designed & Analaysis Tool”工具，在弹出的

界面中按照所需滤波器修改以下参数： 

（1） 滤波器类型：低通 Lowpass； 

（2） 滤波方式： 等纹波 FIR（Equiripple）； 

（3） 滤波器阶数：Specify order（31+1 阶）； 

（4） 采样频率：1000Hz； 

（5） 通带截止频率：150Hz； 

（6） 阻带截止频率：350Hz ； 

 如下图所示： 
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图 143 

 

 点击“Filter Designed & Analaysis Tool”工具菜单“Target->Generate C Header”，在

弹出的窗口中修改“Export as”参数为“Single-precision float”（单精度浮点型），如下

图所示： 
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图 144 

 

 最后点击 Generate 生成包含滤波器系数的.h 头文件。此头文件的数据用于 FIR 函数，

如下图所示： 

 

 

图 145 

 

备注： 

（1） 信号频率 100Hz，噪声频率 450Hz ； 

（2） 采用 TI C6000 DSP 库开发，选用实数 FIR 非优化滤波函数； 

6.33 IIR——无限脉冲响应数字滤波器 

Coming Soon. 

 

http://baike.baidu.com/view/1176449.htm
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TI TMS320C6748 中文论坛 

http://www.deyisupport.com/question_answer/dsp_arm/c6000_dsp/f/32.aspx 

TI TMS320C6748 英文论坛 

http://e2e.ti.com/support/dsp/tms320c6000_high_performance_dsps/f/115.aspx 

TI 官网 

www.ti.com 

TI WIKI 

http://processors.wiki.ti.com/ 
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图 146 
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